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1 Willkommen in der Welt von GUITAR RIG!

 

GUITAR RIG KONTROL ist die Komplettlösung für Gitarristen und Bassisten. Das bühnentaug-
liche Fußpedal RIG KONTROL integriert sich nahtlos in die Bedienung der GUITAR-RIG-Soft-
ware und bietet mit seinem eingebauten Audio-Interface Sound in Studio-Qualität. Es ist für
GUITAR RIG optimiert, aber da es den Industriestandards entspricht und MIDI voll unterstützt,
arbeitet es mit nahezu jeder professionellen Musiksoftware ebenso gut zusammen.

Die RIG KONTROL wird über eine schnelle USB-2.0-Schnittstelle verbunden, die zugleich zur
Stromversorgung dient. Sie ist mit zwei Eingängen zum Anschluss von elektrischen Gitarren
und Bässen sowie von vorverstärkten (Line-)Signalen ausgestattet. Der zweikanalige Ausgang
kann mit einem Monitoring-System verbunden werden, darüber hinaus steht ein separat regel-
barer Stereo-Ausgang zum Anschluss eines Kopfhörers zur Verfügung.

In ihrer Funktion als Controller bietet die RIG KONTROL neun Fußschalter und ein Pedal, um
nahezu alle Funktionen von GUITAR RIG zu steuern. Darüber hinaus verfügt sie über MIDI Ein-
und Ausgänge, sowie zwei analoge Eingänge für den Anschluss von externen Fußpedalen.

sIn den folgenden Kapiteln erfahren Sie mehr über die RIG KONTROL und ihren Einsatz. Bitte
lesen Sie das Handbuch aufmerksam durch, um sich mit dem Gerät vertraut zu machen.

Willkommen in der Welt von GUITAR RIG!
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2 Vor der Inbetriebnahme – Wichtige Hinweise

 

Auch wenn Sie am liebsten gleich loslegen möchten, empfehlen wir, dieses Kapitel sorgfältig
zu durchzulesen.

2.1 Seriennummern und Typenschild
 

GUITAR RIG Kontrol wird mit zwei Seriennummern ausgeliefert. Die Seriennummer für die
RIG KONTROL befindet sich auf der Unterseite des Geräts, ebenso wie das Typenschild, das
die Modellbezeichnung sowie weitere technische Informationen enthält. Die Seriennummer zur
Aktivierung der GUITAR-RIG-Software befindet sich auf der Hülle der Produkt-DVD.

2.2 Sicheres Verwenden des Geräts
 

Bitte lesen Sie die folgenden Abschnitte aufmerksam durch, um gesundheitliche Risiken und
eine Beschädigung des Produkts zu vermeiden.

2.2.1 Achtung
 

Um einem Schaden an Ihrem Gehör vorzubeugen, beachten Sie bitte die folgenden Hinweise:

▪ Dieses Produkt kann in Kombination mit Verstärkern, Lautsprechern oder Kopfhörern sehr
hohe Pegel erzeugen, die Ihre Ohren schädigen können.

▪ Stellen Sie sicher, dass alle Lautstärke-Regler heruntergedreht sind, bevor Sie RIG KON-
TROL verwenden. Drehen Sie die Lautstärkepegel während der Wiedergabe langsam bis
zum gewünschten Pegel auf.

▪ Setzen Sie das Produkt nicht über längere Zeit bei hoher Lautstärke ein. Sollten Sie Ge-
hörprobleme bemerken, suchen Sie bitte umgehend einen Facharzt auf.

Vor der Inbetriebnahme – Wichtige Hinweise
Seriennummern und Typenschild
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2.2.2 Vorsicht
 

Um sicherzustellen, dass die RIG KONTROL oder andere angeschlossene Geräte während der
Benutzung nicht beschädigt werden, beachten Sie bitte die folgenden Hinweise:

▪ Öffnen Sie auf keinen Fall das Gehäuse und versuchen Sie nicht, Komponenten auseinan-
derzubauen oder zu modifizieren. Die Bestandteile dieses Geräts sind vom Nutzer weder
zu warten noch zu reparieren. Falls während des Betriebs Fehlfunktionen auftreten, stel-
len Sie die Nutzung sofort ein und lassen Sie das Gerät von qualifiziertem Fachpersonal
überprüfen.

▪ Schützen Sie das Gerät vor Regen und nutzen Sie es nicht in unmittelbarer Nähe von
Wasser oder in feuchter Umgebung.

▪ Es dürfen zu keiner Zeit Objekte oder Flüssigkeiten jeglicher Art in das Innere des Gehäu-
ses gelangen.

▪ Setzen Sie das Gerät niemals extremen Temperaturen oder intensiven Vibrationen aus
(z. B. direktem Sonnenlicht in einem geschlossenen Fahrzeug, auf Heizkörpern oder an-
deren Hitze erzeugenden Geräten).

▪ Platzieren Sie die RIG KONTROL nicht in einer instabilen Position, in der sie herunterfal-
len könnte. Entfernen Sie sämtliche angeschlossenen Kabel, bevor Sie die RIG KONTROL
transportieren.

▪ Stellen Sie vor dem Ausschalten sicher, dass die Lautstärke sämtlicher Geräte komplett
heruntergedreht ist.

▪ Üben Sie bei der Bedienung der Regler und Anschlüsse niemals Gewalt aus.

▪ Benutzen Sie zur Reinigung der RIG KONTROL ein trockenes, weiches Tuch. Verwenden
Sie niemals Lösungsmittel, Farbverdünner, Reinigungsflüssigkeiten oder chemisch im-
prägnierte Wischtücher.

2.2.3 Entsorgung
 

Sollten Sie dieses Produkt entsorgen wollen, so befolgen Sie bitte die geltenden lokalen und
nationalen Regularien zur Entsorgung elektronischer Produkte.

Vor der Inbetriebnahme – Wichtige Hinweise
Sicheres Verwenden des Geräts
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2.3 Haftungsausschluss
 

Die Native Instruments GmbH kann zu keinem Zeitpunkt für etwaige Schäden oder Datenver-
luste zur Verantwortung gezogen werden, die durch unsachgemäßen Betrieb oder durch Modifi-
kationen der RIG KONTROL oder der zugehörigen Software entstehen.

Zum Zeitpunkt der Publikation wurden die Informationen in diesem Handbuch als korrekt er-
achtet. Die Native Instruments GmbH behält sich vor, die Spezifikationen der Software oder
der Hardware jederzeit unangekündigt und ohne Verpflichtung zur Aktualisierung bereits exis-
tierender Geräte zu ändern.

Vor der Inbetriebnahme – Wichtige Hinweise
Haftungsausschluss
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3 Die RIG-KONTROL-Hardware

 

Dieses Kapitel gibt Ihnen einen Überblick über die Elemente der RIG KONTROL.

3.1 Oberseite
 

Die Oberseite des RIG KONTROL.

(1) Diesen Fußschaltern können Funktionen der Software zugewiesen werden, wie z. B. das
Umschalten von Presets oder das An- und Ausschalten einzelner Komponenten. Jeder Schalter
verfügt über eine LED, die anzeigt, ob er derzeit aktiviert ist. Die obere Reihe ist mit häufig
verwendeten Funktionen von GUITAR RIG beschriftet, die den entsprechenden Schaltern stan-
dardmäßig zugewiesen sind.

Die RIG-KONTROL-Hardware
Oberseite
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(2) Das Fußpedal dient zur Steuerung von beliebigen kontinuierlichen Parametern der Soft-
ware, z. B. Volumen oder WahWah. Unter der Spitze des Pedals befindet sich ein weiterer frei
zuweisbarer Schalter.

(3) Zeigt die Nummer des derzeit aktivierten Presets an.

(4) Diese LEDs zeigen den Pegel des Eingangssignals an. Die roten LEDs zeigen Übersteuerung
an und sollten nicht aufleuchten, während Sie spielen. Falls dies der Fall ist, regeln Sie die
Verstärkung des Eingangssignals herunter.

(5) Diese LEDs zeigen den Pegel des Ausgangssignals an. Die roten LEDs zeigen Übersteue-
rung an und sollten nicht aufleuchten, während Sie spielen. Falls dies der Fall ist, regeln Sie
die Augangslautstärke herunter.

(6) Diese LED leuchtet auf, wenn die RIG KONTROL MIDI-Signale von einem Sequencer oder
einem anderen Controller empfängt.

(7) Diese LED zeigt an, ob der Schalter unter dem Fußpedal aktiviert ist.

3.2 Rückseite
 

Die Rückseite des RIG KONTROL.

(1) Der Inst-/Line-Schalter beeinflusst die Eingangsempfindlichkeit für Input 1 und 2. Wenn er
gedrückt ist, eignen sich die Eingänge für Instrumentensignale, z. B. von Gitarre und Bass.
Wenn er nicht gedrückt ist, empfangen sie vorverstärkte (Line-)Signale. Der ausgewählte Ein-
gangstyp wird auch auf der Oberseite des Geräts angezeigt.

(2) Dieser Knopf regelt die Verstärkung von Input 1.

Die RIG-KONTROL-Hardware
Rückseite
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(3) Der Klinkeneingang für Input 1 (¼”, TRS symmetrisch) kann sowohl Instrumentensignale
als auch vorverstärkte (Line-)Signale empfangen, abhängig vom Line-/Inst-Schalter. Verbinden
Sie Ihn mit einer Gitarre, einem Bass oder dem linken Kanal einer Stereo-Quelle.

(4) Der Klinkeneingang für Input 2 (¼”, TRS symmetrisch) kann sowohl Instrumentensignale
als auch vorverstärkte (Line-)Signale empfangen, abhängig vom Line-/Inst-Schalter. Verbinden
Sie Ihn mit einer Gitarre, einem Bass oder dem rechten Kanal einer Stereo-Quelle.

(5) Dieser Knopf regelt die Verstärkung von Input 2.

(6) Diese Klinkenstecker übertragen das Ausgangssignal. Sie können mit symmetrischen (TRS)
sowie unsymmetrischen Steckern verwendet werden.

(7) Mit diesem Schalter kann die Verstärkung des Ausgangssignal um 14 dB abgesenkt wer-
den.

(8) Dieser Knopf regelt die Lautstärke des Kopfhörerausgangs.

(9) Der Kopfhörerausgang zum Anschluss eines Stereokopfhörers.

(10) Diese analogen Eingänge ermöglichen den Anschluss von externen Fußpedalen und –
schaltern.

(11) Die RIG KONTROL verfügt über ein integriertes MIDI-Interface mit je einem Eingang und
einem Ausgang. Für die Kommunikation zwischen der RIG KONTROL und GUITAR RIG wird
keine MIDI-Verbindung benötigt; Sie können aber MIDI-Daten an andere Programme senden
oder von diesen Programmen gesendete Daten über den MIDI-Ausgang ausgeben lassen.

(12) Der USB-Anschluss verbindet die Hardware mit Ihrem Rechner. Ihr Computer muss über
eine USB-2.0-Schnittstelle verfügen, um mit der Hardware kompatibel zu sein. Die RIG KON-
TROL bezieht ihren Strom aus dem USB. Verbinden Sie das Gerät direkt mit dem USB-2.0-
Anschluss Ihres Rechners und vermeiden Sie die Nutzung von USB-Hubs ohne Stromversor-
gung. Sichern Sie das USB-Kabel stets vor versehentlichem Herausziehen, indem Sie es ein-
mal um den zugehörigen Sicherungshaken wickeln.

Die RIG-KONTROL-Hardware
Rückseite
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4 Installation unter Windows

 

Dieses Kapitel beschreibt die Installation der RIG-KONTROL-Hardware unter Windows 7, wo-
bei der Schwerpunkt auf dem Einrichten des Audio-Interfaces liegt. Informationen zum Ver-
wenden des Pedals als Controller in GUITAR RIG und zu den MIDI-Fähigkeiten finden Sie in
Kapitel ↑7, Die RIG KONTROL als Controller verwenden in diesem Handbuch.

Detaillierte Informationen zu GUITAR RIG finden Sie in den Software-Handbüchern. Sie befin-
den sich auf der Produkt-DVD und im Programm-Menü unter Help > Open Manual > German.

4.1 Installation der Software
 

Stellen Sie sicher, dass Sie mit Administrator-Rechten eingeloggt sind. Verbinden Sie die RIG
KONTROL noch nicht mit ihrem Computer.

1. Navigieren Sie zum Inhalt der Produkt-DVD und suchen Sie die Setup-Datei. Falls Sie ei-
ne Download-Version von GUITAR RIG benutzen, müssen Sie die Setup-Dateien zunächst
entpacken.

Installation unter Windows
Installation der Software
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2. Doppelklicken Sie die GUITAR-RIG-Setup-Datei ("Guitar Rig 5 [Versionsnummer] Setup
PC.exe), um die Installation zu beginnen.

3. Folgen Sie den Anweisungen auf dem Bildschirm, um durch den Installationsprozess ge-
führt zu werden. Wir empfehlen die Installation der Software an den vorgegebenen Spei-
cherort.

4. Sie werden aufgefordert, den Pfad zu dem VST-Plug-In-Ordner Ihres Rechners anzugeben.
Falls Sie nicht wissen, was ein VST-Plug-In ist, oder wenn Sie sicher sind, dass Sie GUI-
TAR RIG nur im Stand-Alone-Modus betreiben, verwenden Sie einfach die Standardein-

Installation unter Windows
Installation der Software
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stellung. Wenn Sie GUITAR RIG als Plug-In in einer Host-Software verwenden möchten,
müssen Sie den Pfad zu dem Plug-In-Ordner Ihrer Host-Software ändern.

Installation unter Windows
Installation der Software
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5. Sie werden gefragt, ob Sie Treiber für die Audio-Interfaces von GUITAR RIG installieren
möchten. Machen Sie neben Install the Rig Kontrol 3 Driver ein Häkchen und klicken Sie
auf Next.

6. Falls Sie dazu aufgefordert werden, starten Sie Ihren Computer nach der Installation neu.
Das Installationsprogramm platziert die folgende Software auf ihrem Computer:

▪ Die eigenständig funktionierende GUITAR-RIG-Software.

▪ GUITAR-RIG-Plug-Ins: GUITAR RIG lässt sich als Plug-In für Ihre Digital Audio Workstati-
on (DAW) benutzen. Auf einem Windows Computer werden die Plug-In-Formate VST und
RTAS unterstützt.

▪ Das Service Center – Dieses Programm dreht sich um Produkt-Aktivierungen und das Ma-
nagement von Updates. Bitte konsultieren Sie die Installationsanleitung (Setup Guide) für
Details zur Produktaktivierung.

▪ Die Hardware-Treiber für die RIG KONTROL.

Installation unter Windows
Installation der Software
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Falls Sie nur die Hardware-Treiber installieren wollen, finden Sie dafür auf der Installations-
DVD eine separate Installations-Datei. Die aktuelle Treiberversion finden Sie jederzeit im Be-
reich „Support“ der Native-Instruments-Website.

4.2 Installation der Hardware
 

Benutzen Sie das mitgelieferte USB-Kabel, um die RIG KONTROL direkt an einen USB 2.0
Port Ihres Computers anzuschließen.

Anschließen des Controllers and Ihren Computer.

Die RIG KONTROL wird per USB mit Strom versorgt. Die Funktion kann nur garantiert werden,
wenn Sie es als einziges Gerät direkt an einem USB-2.0-Controller oder an einem USB-2.0-
Hub mit eigener Stromversorgung betreiben.

► Nach der erfolgreichen Installation wird die RIG KONTROL beim Herstellen der USB-Ver-
bindung automatisch erkannt. Andernfalls starten Sie bitte die Installation erneut, wie oben
beschrieben.

Es werden nun verschiedene Treiber mit der RIG KONTROL assoziiert, wobei jedesmal ein klei-
nes Fenster erscheint, das Ihnen Auskunft über den installierten Treiber gibt.

Installation unter Windows
Installation der Hardware
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Auf Windows-Rechnern wird der Treiber mit einem bestimmten USB-Port assoziiert. Wenn
Sie das USB-Kabel mit einem anderen USB-Port verbinden, kann es deshalb vorkommen,
dass der beschriebene Vorgang erneut startet.

Falls der Computer die RIG KONTROL beim Verbinden nicht erkennt, trennen Sie die Ver-
bindung und warten Sie einige Sekunden. Beim erneuten Verbinden sollte das Interface er-
kannt werden. Falls das Problem weiter besteht, starten Sie den Computer mit bestehender
Verbindung zum Interface neu.

4.3 Konfiguration
 

Dieses Kapitel beschreibt, wie Sie die RIG KONTROL für die Benutzung unter Windows, und
insbesondere mit der GUITAR-RIG-Software einrichten. Es wird vorausgesetzt, dass Sie Ihre In-
stallation von GUITAR RIG bereits über das Service Center aktiviert haben. Falls nicht, entneh-
men Sie bitte weitere Informationen hierzu dem Installationshandbuch.

4.3.1 GUITAR RIG konfigurieren
 

Wir werden nun Ihr RIG KONTROL Audio-Interface unter GUITAR RIG einrichten.

► Starten Sie die Software, bevor Sie fortfahren.

Beim ersten Start der Software wird automatisch der Dialog Audio and MIDI Settings geöffnet,
in dem Sie die notwendigen Einstellungen vornehmen können (um zu einem späteren Zeit-
punkt zu diesen Einstellungen zu gelangen, wählen Sie aus dem Programm-Menü File > Audio
and MIDI Settings).

Installation unter Windows
Konfiguration
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Das "Audio and MIDI Settings"-Fenster.

1. Wählen Sie auf dem Audio-Tab ASIO aus dem Drop-Down-Menü "Driver".
2. Wählen Sie danach RIG KONTROL 3 als “Device” für den Ausgang der Software.
3. Wählen Sie eine Sample-Rate, die zu Ihrer Musikanwendung kompatibel ist und zur Leis-

tungsfähigkeit Ihres Computers passt. Als Standard ist die Sample-Rate auf 44100 Hz
(CD-Qualität) eingestellt. Höhere Sample-Raten können die Soundqualität verbessern, ver-
ursachen jedoch gleichzeitig eine höhere CPU-Last – und 44100 Hz ist eine häufig ver-
wendete Einstellung.

Falls RIG KONTROL 3 nicht in der Liste auftaucht, ist etwas schief gelaufen. Starten Sie die
Installation erneut wie in ↑4.1, Installation der Software beschrieben.

Experteneinstellung

Zusätzliche Informationen zum Vornehmen erweiterter Konfigurations-Einstellungen über das
Treiber-Bedienfeld, finden Sie in Abschnitt ↑5.4, Audio-Verbindungen und Pegel.

Installation unter Windows
Konfiguration
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4.3.2 Die RIG KONTROL als Standard-Audio-Interface einrichten
 

Wenn Sie die RIG KONTROL für die Wiedergabe sämtlicher Audio-Software (nicht nur für die
Musikproduktion) benutzen wollen, müssen Sie es als Standard-Audio-Interface einrichten.
Unter Windows 7 gehen Sie folgendermaßen vor:

1. Öffnen Sie Start > Systemsteuerung > Hardware und Sound > Sound.
2. Wählen Sie den Tab Wiedergabe.
3. Wählen Sie in der Geräteliste Rig Kontrol 3 Output aus und klicken Sie auf Set Default.
4. Wählen Sie den Tab Aufnahme.
5. Wählen Sie in der Geräteliste Rig Kontrol 3 Input aus und klicken Sie auf Set Default.
6. Klicken Sie auf OK, um den Dialog zu schließen.

Installation unter Windows
Konfiguration
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4.4 Audio-Verbindungen und Pegel
 

In den folgenden Kapiteln erfahren Sie, wie Sie Ihre Gitarre oder Ihren Bass und Ihr Wiederga-
be-System an die RIG KONTROL anschließen, und wie Sie die richtige Verstärkung einstellen,
sowohl auf Seiten der Hardware als auch in der Software. Bitte starten Sie zuvor GUITAR RIG.

4.4.1 Anschließen Ihres Instruments und Anpassen des Eingangspegels
 

1. Bitte drehen Sie die Lautstärke Ihres Wiedergabesystems komplett herunter, um Gehör-
schädigung vorzubeugen.

2. Stellen Sie sicher, dass der Input-Wahlschalter auf "Instrument Input Amplification" (In-
strument Eingangsverstärkung) gestellt ist (LINE-/INST-Button auf der Rückseite der RIG
KONTROL ist eingedrückt), außer Sie benutzen einen Vorverstärker, um Ihr Signal auf Li-
ne-Level zu verstärken.

3. Verbinden Sie Ihre Gitarre oder Ihren Bass mit einem entsprechenden Kabel mit einem
der Eingangsstecker der RIG KONTROL.

4. Drehen Sie die Eingangslautstärke des unbenutzten Kanals ganz runter, um Störgeräu-
sche zu vermeiden.

Falls Sie ein Instrument anschließen wollen, das ein Stereo-Signal erzeugt – z. B. einen Syn-
thesizer – müssen Sie es mit beiden Eingangskanälen verbinden.

Installation unter Windows
Audio-Verbindungen und Pegel
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Eine Gitarre/Bassgitarre an den Controller anschließen.

Um die optimale Klangqualität zu erzielen, müssen Sie das Interface mit einem ausreichend
verstärkten Eingangssignal ansteuern. Dazu müssen Sie den Regler “Input Level” (Eingangspe-
gel) des verwendeten Kanals sorgfältig einstellen. Die Eingangs-Pegelanzeige hilft Ihnen bei
der korrekten Vorverstärkung Ihres Signals.

Pegelanzeige Bedeutung

Alle LEDs sind aus Kein Eingangssignal

Grüne LEDs leuchten Ein Eingangssignal liegt
vor

Grüne und rote LEDs
leuchten

Eingangssignal ist zu laut

Bitte drehen Sie die Lautstärke Ihres Instruments auf, bevor Sie die folgenden Schritte vorneh-
men. Spielen Sie einige Akkorde in der gewohnten Lautstärke und schauen Sie auf die Ein-
gangs-Pegelanzeige:

1. Drehen Sie den “Input Level”-Regler neben dem benutzten Eingangsstecker auf, bis die
roten LEDs anfangen, zu leuchten, während Sie spielen.

2. An diesem Punkt müssen Sie den Regler sachte zurückdrehen, bis die LED auch dann
nicht mehr rot leuchtet, wenn Sie sehr laut spielen.

Nun ist die Eingangsempfindlichkeit optimal eingestellt, was dem Interface ermöglicht, die
größte dynamische Bandbreite ohne Übersteuerung zu verarbeiten.
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4.4.2 Ein zweites Instrument anschließen
 

Sie können an beide Eingangskanäle verschiedene Instrumente anschließen, unter der Bedin-
gung, dass beide den gleichen Ausgangspegel erzeugen (Line oder Instrument). Verbinden Sie
Ihr zweites Instrument mit dem zweiten Eingangsstecker und stellen sie die entsprechende
Vorverstärkung ein, wie im vorherigen Abschnitt erklärt.

Sofern Ihr Instrument nur einen Kanal nutzt, stellen Sie bitte den Gain-Regler des anderen
Kanals auf Null.

Bei einem Stereo-Instrument muss der zweite Kanal verbunden sein, um Stereo-Sound zu er-
halten.

4.4.3 Der Eingangspegel (Input Level) in GUITAR RIG
 

Es wird vorausgesetzt, dass Ihre Gitarre nun mit der RIG KONTROL verbunden und die Ein-
gangsempfindlichkeit optimal ausgesteuert ist (siehe ↑4.4.1, Anschließen Ihres Instruments
und Anpassen des Eingangspegels). Nun müssen wir uns versichern, dass das Eingangssignal
auch in der Software bei optimaler Lautstärke verarbeitet wird.

Bitte richten Sie ihre Aufmerksamkeit auf die Kopfzeile des GUITAR-RIG-Fensters. Sie enthält
das Eingangsmodul (Input Module) mit der Kanalauswahl (L/R), ein einfaches Noise Gate und
einen Limiter sowie Informationen über die Auslastung Ihrer CPU.

Die Kopfzeile der GUITAR-RIG-Software.

Achten Sie auf die Eingangs-Pegelanzeige in der Software – sie zeigt einen Ausschlag, wenn
Sie spielen. Die Anzeige verfügt über einen integrierten Lautstärke-Regler, der die Eingangs-
verstärkung regelt. Stellen Sie ihn so ein, dass die höchstmögliche Lautstärke erreicht wird,
ohne dass der Eingang übersteuert. Dies ist der Fall, wenn der Pegel nahe am roten Bereich
der Anzeige ist, ohne diesen jemals zu erreichen.

Wenn nur eine Gitarre verbunden ist, empfängt GUITAR RIG ein Mono-Signal. Sie können das
Input Modul so einstellen, dass dieses Signal in der Software auf beiden Kanälen übertragen
wird. Da GUITAR RIG standardmäßig so eingestellt ist, dass sie beide Eingangskanäle getrennt
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verarbeitet (Beide Kanäle sind aktiviert), bleibt der rechte Kanal stumm. Um ihn zu deaktivie-
ren, klicken Sie auf den entsprechenden Buchstaben (L oder R) neben der Eingangspegel-An-
zeige. Dies führt dazu, dass der linke Kanal auf beide Eingangskanäle gelenkt wird.

4.4.4 Verbindung des Ausgangs
 

Die RIG KONTROL verfügt über zwei Mono-Ausgänge, um ihr Wiedergabesystem anzuschlie-
ßen, sei es ein Mischpult, ein paar Aktivboxen, oder Ihre Stereoanlage. Beachten Sie, dass für
Stereo-Sound beide Ausgänge verbunden sein müssen. Ein separater Stereo-Ausgang (TRS) er-
laubt den Anschluss eines Kopfhörers.

Lautsprecher und Kopfhörer mit dem Controller verbinden.

1. Verbinden Sie die Ausgangsstecker mit dem Eingang Ihres Wiedergabesystems. Stellen
sie an letzerem die gewohnte Lautstärke ein.

2. Falls Sie einen Kopfhörer benutzen möchten, verbinden Sie diesen mit dem Kopfhörer-
ausgang. Achten Sie daruaf, dass der Lautstärkeregler für den Kopfhörer völlig herunter-
gedreht ist, bevor Sie ihn aufsetzen.

3. Öffnen Sie den Preset-Browser und suchen Sie sich ein Preset aus. Laden Sie es, indem
Sie einen Doppelklick darauf ausführen.
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4. Drehen sie die Lautstärke vorsichtig auf, während Sie spielen, bis die gewünschte Laut-
stärke erreicht ist.

Sie sind nun am Ende der Installation angelangt und können sofort loslegen!
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5 Installation unter Mac OS X

 

Dieses Kapitel beschreibt die Installation der RIG-KONTROL-Hardware unter Mac OS X, wobei
der Schwerpunkt auf dem Einrichten des Audio-Interfaces liegt. Informationen zum Verwenden
des Pedals als Controller in GUITAR RIG und zu den MIDI-Fähigkeiten finden Sie in Kapitel
↑7, Die RIG KONTROL als Controller verwenden in diesem Handbuch.

Detaillierte Informationen zu GUITAR RIG finden Sie in den Software-Handbüchern. Sie befin-
den sich auf der Produkt-DVD und im Programm-Menü unter Help > Open Manual > German.

5.1 Installation der Software
 

Stellen Sie sicher, dass Sie mit Administrator-Rechten eingeloggt sind. Verbinden Sie die RIG
KONTROL noch nicht mit ihrem Computer.

1. Navigieren Sie zum Inhalt der Installations-DVD und finden Sie die Installations-Datei “
Guitar Rig Installer”. Falls Sie eine Download-Version von GUITAR RIG benutzen, müssen
Sie die Installations-Datei zunächst entpacken.

2. Doppelklicken Sie auf die Installations-Datei, um den Installationsprozess zu beginnen.
3. Folgen Sie den Anweisungen auf dem Bildschirm, um durch den Installationsprozess ge-

führt zu werden.
4. Sie werden gefragt, ob Sie Treiber für ein GUITAR-RIG-Audio-Interface installieren möch-

ten. Wählen Sie den Treiber RIG KONTROL 3 (möglicherweise ist dieser bereits ausge-
wählt) und klicken Sie auf Continue.

5. Starten Sie Ihren Computer nach der Installation neu.
Das Installationsprogramm platziert die folgende Software auf ihrem Computer:

▪ Die eigenständig funktionierende GUITAR-RIG-Software.

▪ GUITAR RIG Plug-Ins – GUITAR RIG lässt sich als Plug-In für Ihre Digital Audio Worksta-
tion (DAW) benutzen.

▪ Das Service Center – Dieses Programm dreht sich um Produkt-Aktivierungen und das Ma-
nagement von Updates. Bitte konsultieren Sie die Installationsanleitung (Setup Guide) für
Details zur Produktaktivierung.
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▪ Die Hardware-Treiber für die RIG KONTROL.

Wenn Sie bisher noch kein Produkt von Native Instruments besitzen, müssen Sie sich bei
Native Instruments registrieren, indem Sie den Anweisungen auf den Bildschirm folgen.
Mehr Informationen über die Erstellung eines NI User Accounts und über die Aktivierung
von GUITAR RIG finden Sie im Setup Guide und im Service-Center-Handbuch.

Falls Sie nur die Hardware-Treiber installieren wollen, finden Sie dafür auf der Installations-
DVD eine separate Installations-Datei. Die aktuelle Treiberversion finden Sie jederzeit im Be-
reich „Support“ der Native-Instruments-Website.

5.2 Installation der Hardware
 

Benutzen Sie das mitgelieferte USB-Kabel, um die RIG KONTROL direkt an einen USB 2.0
Port Ihres Computers anzuschließen.

Anschließen des Controllers and Ihren Computer.

Die RIG KONTROL wird per USB mit Strom versorgt. Die Funktion kann nur garantiert werden,
wenn Sie es als einziges Gerät direkt an einem USB-2.0-Controller oder an einem USB-2.0-
Hub mit eigener Stromversorgung betreiben.
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► Nach der erfolgreichen Installation wird die RIG KONTROL beim Herstellen der USB-Ver-
bindung automatisch erkannt. Andernfalls starten Sie bitte die Installation erneut, wie oben
beschrieben.

Es werden nun verschiedene Treiber mit der RIG KONTROL assoziiert, wobei jedesmal ein klei-
nes Fenster erscheint, das Ihnen Auskunft über den installierten Treiber gibt.

Falls der Computer die RIG KONTROL beim Verbinden nicht erkennt, trennen Sie die Ver-
bindung und warten Sie einige Sekunden. Beim erneuten Verbinden sollte das Interface er-
kannt werden. Falls das Problem weiter besteht, starten Sie den Computer mit bestehender
Verbindung zum Interface neu.

5.3 Konfiguration
 

Dieses Kapitel beschreibt, wie Sie das RIG-KONTROL-Audio-Interface für die Benutzung unter
Mac OS X, und insbesondere mit der GUITAR-RIG-Software einrichten. Es wird vorausgesetzt,
dass Sie Ihre Installation von GUITAR RIG bereits über das Service Center aktiviert haben.
Falls nicht, entnehmen Sie bitte weitere Informationen hierzu dem Installationshandbuch.

5.3.1 GUITAR RIG konfigurieren
 

Wir werden nun Ihr RIG KONTROL Audio-Interface unter GUITAR RIG einrichten. Starten Sie
die Software, bevor Sie fortfahren.
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1. Beim ersten Start der Software wird automatisch der Dialog Audio and MIDI Settings ge-
öffnet, in dem Sie die notwendigen Einstellungen vornehmen können. Um diese Einstel-
lungen später zu bearbeiten, wählen Sie Guitar Rig > Preferences aus dem Programm-Me-
nü.

2. Wählen Sie auf dem Audio-Tab CoreAudio als Driver-Interface aus.
3. Wählen Sie danach RigKontrol3 als Device für den Ausgang der Software.

Falls RIG KONTROL nicht in der Liste auftaucht, ist etwas schief gelaufen. Starten Sie die
Installation erneut wie in ↑5.1, Installation der Software beschrieben.

Das Audio-Interface lässt sich über folgende Parameter konfigurieren:

▪ Sample Rate: Wählen Sie eine Samplerate, die mit Ihrer Musiksoftware kompatibel und
auf die Prozessorleistung Ihres Computers abgestimmt ist. Als Standard ist die Samplera-
te auf 44100 Hz (CD-Qualität) eingestellt. Höhere Sampleraten können die Soundqualität
verbessern, verursachen jedoch gleichzeitig eine höhere CPU-Last.
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Die Sample-Rate definiert, wie viele Samples eines Sounds pro Sekunde wiedergegeben/auf-
genommen werden. Eine höhere Sample-Rate führt zwar zu einer besseren Audioqualität,
aber 44100 Hz (wird für die Herstellung von Audio-CDs verwendet) ist ein gängiger Wert, der
für die meisten Anwendungen absolut ausreichend ist. Wenn Sie eine CD erstellen möchten,
sollten Sie diese Einstellung verwenden oder ein Vielfaches davon (88200 Hz). Zum bessern
Verständnis: 48000 Hz wird für DAT-Recorder verwendet und für DVD-Aufnahmen (Filme).
96000 Hz ist ein typischer Wert für DVD-, HD-DVD- und Blu-ray-Disc-Aufnahmen. Sie soll-
ten aber im Hinterkopf behalten, dass eine höhere Sample-Rate auch eine größere CPU-Be-
anspruchung mit sich bringt.

▪ Latency: Benutzen Sie den Schieberegler Latency, um die Puffergröße des Audio-Interfa-
ces einzustellen. Die Puffergröße wird in Samples gemessen und hat zwei Auswirkungen:
Je höher die Puffergröße gesetzt ist, desto geringer ist die Wahrscheinlichkeit von Fehlern
während der Echtzeitverarbeitung von Audiosignalen. Andererseits wirkt sich die Puffer-
größe direkt auf die Latenz Ihres Systems aus – je höher sie gesetzt ist, desto länger ist
der Zeitraum zwischen dem Moment, in dem Sie einen Ton anschlagen und dem Moment,
in dem Sie den verarbeiteten Klang hören.

Es ist zu empfehlen, dass Sie zunächst eines der drei obersten Presets auswählen und mit der
Installation fortfahren. Nachdem diese abgeschlossen ist, sollten Sie einen unverzerrten Sound
einstellen und die Audio and MIDI Settings erneut aufrufen, um die bestmögliche Latenz für
Ihr System zu erzielen. Dies erfolgt durch eine behutsame Reduzierung der Puffergröße: Zie-
hen Sie den Schieberegler nach links, während Sie etwas spielen. Sobald Sie ein Knacksen
oder Unterbrechungen in der Wiedergabe wahrnehmen, müssen Sie den Regler wieder ein we-
nig nach recht bewegen, bis keine Fehler mehr auftreten.

5.3.2 Die RIG KONTROL als Standard-Audio-Interface einrichten
 

Wenn Sie GUITAR RIG KONTROL für die Wiedergabe sämtlicher Audio-Software (nicht nur für
die Musikproduktion) benutzen wollen, müssen Sie es als Standard Audio-Interface einrichten.
Unter Mac OS X funktioniert das so:

1. Öffnen Sie die Systemeinstellungen aus dem Apple-Menü.
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2. Wählen Sie den Eintrag Sound.

3. Wählen Sie auf dem Tab Sound Effects RigKontrol3 aus dem Menü Play sound effects
through.

4. Wählen Sie auf dem Tab Output RigKontrol3 aus der Liste Choose a device for sound out-
put.

5. Wählen Sie auf dem Tab Input RigKontrol3 aus der Liste Choose a device for sound input.

5.4 Audio-Verbindungen und Pegel
 

In den folgenden Kapiteln erfahren Sie, wie Sie Ihre Gitarre oder Ihren Bass und Ihr Wiederga-
be-System an die RIG KONTROL anschließen, und wie Sie die richtige Verstärkung einstellen,
sowohl auf Seiten der Hardware als auch in der Software. Bitte starten Sie zuvor GUITAR RIG.
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5.4.1 Anschließen Ihres Instruments und Anpassen des Eingangspegels
 

1. Bitte drehen Sie die Lautstärke Ihres Wiedergabesystems komplett herunter, um Gehör-
schädigung vorzubeugen.

2. Stellen Sie sicher, dass der Input-Wahlschalter auf "Instrument Input Amplification" (In-
strument Eingangsverstärkung) gestellt ist (LINE-/INST-Button auf der Rückseite der RIG
KONTROL ist eingedrückt), außer Sie benutzen einen Vorverstärker, um Ihr Signal auf Li-
ne-Level zu verstärken.

3. Verbinden Sie Ihre Gitarre oder Ihren Bass mit einem entsprechenden Kabel mit einem
der Eingangsstecker der RIG KONTROL.

4. Drehen Sie die Eingangslautstärke des unbenutzten Kanals ganz runter, um Störgeräu-
sche zu vermeiden.

Falls Sie ein Instrument anschließen wollen, das ein Stereo-Signal erzeugt – z. B. einen Syn-
thesizer – müssen Sie es mit beiden Eingangskanälen verbinden.

Eine Gitarre/Bassgitarre an den Controller anschließen.

Um die optimale Klangqualität zu erzielen, müssen Sie das Interface mit einem ausreichend
verstärkten Eingangssignal ansteuern. Dazu müssen Sie den Regler “Input Level” (Eingangs-
empfindlichkeit) des verwendeten Kanals sorgfältig einstellen. Das Eingangs-Pegelanzeige hilft
Ihnen bei der korrekten Vorverstärkung Ihres Signals:
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Pegelanzeige Bedeutung

Alle LEDs sind aus Kein Eingangssignal

Grüne LEDs leuchten Ein Eingangssignal liegt
vor

Grüne und rote LEDs
leuchten

Eingangssignal ist zu laut

Bitte drehen Sie die Lautstärke Ihres Instruments auf, bevor Sie die folgenden Schritte vorneh-
men. Spielen Sie einige Akkorde in der gewohnten Lautstärke und schauen Sie auf die Ein-
gangs-Pegelanzeige.

1. Drehen Sie den “Input Level”-Regler neben dem benutzten Eingangsstecker auf, bis die
roten LEDs anfangen zu leuchten, während Sie spielen.

2. An diesem Punkt müssen Sie den Regler sachte zurückdrehen, bis die LED auch dann
nicht mehr rot leuchtet, wenn Sie sehr laut spielen.

Nun ist die Eingangsempfindlichkeit optimal eingestellt, was dem Interface ermöglicht, die
größte dynamische Bandbreite ohne Übersteuerung zu verarbeiten.

5.4.2 Ein zweites Instrument anschließen
 

Sie können an beide Eingangskanäle verschiedene Instrumente anschließen, unter der Bedin-
gung, dass beide den gleichen Ausgangspegel erzeugen (Line oder Instrument). Verbinden Sie
Ihr zweites Instrument mit dem zweiten Eingangsstecker und stellen sie die entsprechende
Vorverstärkung ein, wie im vorherigen Abschnitt erklärt.

Sofern Ihr Instrument nur einen Kanal nutzt, stellen Sie bitte den Gain-Regler des anderen
Kanals auf Null.

Bei einem Stereo-Instrument muss der zweite Kanal verbunden sein, um Stereo-Sound zu er-
halten.

5.4.3 Der Eingangspegel (Input Level) in GUITAR RIG
 

Es wird vorausgesetzt, dass Ihre Gitarre nun mit der RIG KONTROL verbunden und die Ein-
gangsempfindlichkeit optimal ausgesteuert ist (siehe ↑5.4.1, Anschließen Ihres Instruments
und Anpassen des Eingangspegels). Nun müssen wir uns versichern, dass das Eingangssignal
auch in der Software bei optimaler Lautstärke verarbeitet wird.
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Bitte richten Sie ihre Aufmerksamkeit auf die Kopfzeile des GUITAR-RIG-Fensters. Sie enthält
das Eingangsmodul (Input Module) mit der Kanalauswahl (L/R), ein einfaches Noise Gate und
einen Limiter sowie Informationen über die Auslastung Ihrer CPU.

Die Kopfzeile der GUITAR-RIG-Software.

Achten Sie auf die Eingangs-Pegelanzeige in der Software – sie zeigt einen Ausschlag, wenn
Sie spielen. Die Anzeige verfügt über einen integrierten Lautstärke-Regler, der die Eingangs-
verstärkung der Software regelt. Bitte stellen Sie ihn so ein, dass die höchstmögliche Lautstär-
ke erreicht wird, ohne dass der Eingang übersteuert. Dies ist der Fall, wenn der Pegel nahe am
roten Bereich der Anzeige ist, ohne diesen jemals zu erreichen.

Wenn nur eine Gitarre verbunden ist, empfängt GUITAR RIG ein Mono-Signal. Sie können das
Input Modul so einstellen, dass dieses Signal in der Software auf beiden Kanälen übertragen
wird. Da GUITAR RIG standardmäßig so eingestellt ist, dass sie beide Eingangskanäle getrennt
verarbeitet (Beide Kanäle sind aktiviert), bleibt der rechte Kanal stumm. Um ihn zu deaktivie-
ren, klicken Sie auf den entsprechenden Buchstaben (L oder R) neben der Eingangspegel-An-
zeige. Dies führt dazu, dass der linke Kanal auf beide Eingangskanäle gelenkt wird.

5.4.4 Verbindung des Ausgangs
 

Die RIG KONTROL verfügt über zwei Mono-Ausgänge, um ihr Wiedergabesystem anzuschlie-
ßen, sei es ein Mischpult, ein paar Aktivboxen, oder Ihre Stereoanlage. Beachten Sie, dass für
Stereo-Sound beide Ausgänge verbunden sein müssen. Ein separater Stereo-Ausgang (TRS) er-
laubt den Anschluss eines Kopfhörers.
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Lautsprecher und Kopfhörer mit dem Controller verbinden.

1. Verbinden Sie die Ausgangsstecker mit dem Eingang Ihres Wiedergabesystems. Stellen
sie an letzerem die gewohnte Lautstärke ein.

2. Falls Sie einen Kopfhörer benutzen möchten, verbinden Sie diesen mit dem Kopfhörer-
ausgang. Achten Sie daruaf, dass der Lautstärkeregler für den Kopfhörer völlig herunter-
gedreht ist, bevor Sie ihn aufsetzen.

3. Öffnen Sie den Preset-Browser und suchen Sie sich ein Preset aus. Laden Sie es, indem
Sie einen Doppelklick darauf ausführen.

4. Drehen sie die Lautstärke vorsichtig auf, während Sie spielen, bis die gewünschte Laut-
stärke erreicht ist.

Sie sind nun am Ende der Installation angelangt und können sofort loslegen!
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6 Experteneinstellung

 

6.1 Erweiterte Einstellung unter Windows
 

Sie erreichen das Treiber-Bedienfeld (Control Panel), indem Sie in dem "Audio and MIDI Set-
tings"-Fenster (File > Audio and MIDI Settings aus dem GUITAR-RIG-Datei-Menü) auf ASIO
Config klicken. Dort wird Ihnen durch das Statusfeld am unteren Rand angezeigt, ob die RIG-
KONTROL-Hardware verbunden ist und ordnungsgemäß funktioniert.

Das Control-Panel mit geöffneter Audio-Settings-Seite.

6.1.1 Audio-Settings-Seite (Audioeinstellungen)
 

Auf der Audio-Settings-Seite können Sie die Latenzeinstellungen und die Sample-Rate konfi-
gurieren sowie den Gerätestatus überwachen. Die Audio-Settings-Seite besteht aus zwei Berei-
chen: Audio Processing (Audioverarbeitung) und Device Monitor (Geräteüberwachung).
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Audio Processing (Audioverarbeitungs-Sektion)

In der Audio-Processing- (Audioverarbeitungs-) Sektion können Parameter eingestellt werden,
die sich auf die analog-zu-digital/digital-zu-analog-Konvertierung Ihres Audio-Interfaces bezie-
hen. Diese hat zwei Menüpunkte:

▪ Sample-Rate: Wählen Sie eine Sample-Rate, die zu Ihrer Musikanwendung kompatibel ist
und zur Leistungsfähigkeit Ihres Computers passt. Eine höhere Sample-Rate führt zu ei-
ner verbesserten Audioqualität, verursacht aber auch eine größere CPU-Beanspruchung.
Als Standard ist die Sample-Rate auf 44100 Hz (CD-Qualität) eingestellt.

Die Sample-Rate definiert, wie viele Samples eines Sounds pro Sekunde wiedergegeben/auf-
genommen werden. Eine höhere Sample-Rate führt zwar zu einer besseren Audioqualität,
aber 44100 Hz (wird für die Herstellung von Audio-CDs verwendet) ist ein gängiger Wert, der
für die meisten Anwendungen absolut ausreichend ist. Wenn Sie eine CD erstellen möchten,
sollten Sie diese Einstellung verwenden oder ein Vielfaches davon (88200 Hz). Zum bessern
Verständnis: 48000 Hz wird für DAT-Recorder verwendet und für DVD-Aufnahmen (Filme).
96000 Hz ist ein typischer Wert für DVD-, HD-DVD- und Blu-ray-Disc-Aufnahmen. Sie soll-
ten aber im Hinterkopf behalten, dass eine höhere Sample-Rate auch eine größere CPU-Be-
anspruchung mit sich bringt.

Wenn mehrere Software-Programme gleichzeitig auf das Gerät zugreifen sollen, denken Sie
bitte daran, dass diese die gleiche Sample-Rate verwenden müssen.

▪ Process Buffer (Verarbeitungspuffer): Verringern Sie die Puffergröße, um die Reaktionszeit
Ihres Computers auf Ausführungen an einem MIDI-Controller oder der Software zu verkür-
zen.

Bei der Konvertierung von Audioinformationen in digitales Format und umgekehrt muss der
Audio-Treiber die Daten in einem Puffer zwischenspeichern (Audio Buffer) und dann weiter
an die CPU leiten. Je größer dieser Pufferspeicher ist, umso länger dauert es, bis das Signal
am Ausgang hörbar zur Verfügung steht. Sie können dies als Zeitverzögerung wahrnehmen,
die zwischen dem Drücken einer Taste auf Ihrem Controller, der eine Musik-Software auf Ih-
rem Computer steuert, und der erfolgten Audiowiedergabe auftritt. Diese Verzögerung wird
Latenz genannt. Als Faustregel gilt: Eine niedrige Buffergröße führt zu einer niedrigen La-
tenz. Es gibt jedoch noch weitere Faktoren als die Puffergröße, die die Latenz bestimmen
(zum Beispiel CPU-Geschwindigkeit und RAM-Größe). Sie sollten mit höheren Pufferwerten
beginnen und diese schrittweise verringern, bis Sie einen gutes Verhältnis zwischen der
Spielbarkeit und der Audioqualität für Ihr System gefunden haben. Wenn Sie Störgeräusche
in der Audiowiedergabe wahrnehmen, ist die Puffergröße für die Leistungsfähigkeit der CPU
Ihres Computers wahrscheinlich zu niedrig gewählt, da niedrige Puffergrößen eine höhere
CPU-Beanspruchung mit sich bringen.
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▪ USB Buffer (USB-Puffer): Verwenden Sie dieses Menü, wenn Sie über das Verarbeitungs-
puffer-Menü (Process Buffer) keine zufriedenstellenden Latenzwerte erreichen. Verringern
Sie die Größe des USB-Puffers, um die Latenz weiter zu verringern. Sollten Sie Störungen
im Audiosignal wahrnehmen, erhöhen Sie die Puffergröße so weit, bis Sie wieder einen
störungsfreien Klang erreichen.

Device-Monitor-Sektion

Device Monitor (Geräteüberwachung): zeigt die Informationen über den Verarbeitungsstatus
und die Ausgangslatenz des Audio-Interfaces an. Dieser hat zwei Anzeigen:

▪ Processing State (Verarbeitungs-Status): Die Anzeige des Verarbeitungs-Status gibt eine
Rückmeldung über den aktuellen Status des Geräts. Es gibt drei mögliche Statusmeldun-
gen:

◦ Idle (Leerlauf): der Controller wurde angeschlossen, es findet aber kein Audiodaten-
transport statt.

◦ Streaming (Audio wird wiedergegeben): der Treiber arbeitet und verarbeitet Audiodaten.

◦ Panic: Der Treiber hat die Verarbeitung der Audiodaten gestoppt. Es sind zu viele USB-
Eingabe/Ausgabe-Fehler bei der Kommunikation mit dem Interface aufgetreten.

▪ Output Latency (Ausgabelatenz): zeigt die Ausgangslatenz (-verzögerung) in Millisekunden
an.

6.1.2 Diagnostics Page (Fehlerdiagnose)
 

Die Informationen auf der Diagnostics-Seite sind vor allem für fortgeschrittene Anwender ge-
dacht; wenn es zu Problemen kommt, sollten Sie immer auch einen Blick auf diese Seite wer-
fen.

Die Diagnostics-Seite besteht aus drei Bereichen:

▪ Drop-Out Detection (Audioaussetzer): zeigt die USB-Eingabe-/Ausgabefehler und Puffer-
leerläufe an.

▪ Connection Monitor (Verbindungsanzeige): zeigt Fehler an, die bei der USB-Kommunikati-
on zwischen dem Controller und dem Computer auftreten können.

▪ System Performance Test: bietet die Möglichkeit, einen Leistungstest zum Ermessen von
Latenzwerten auszuführen.
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▪ Information: zeigt Informationen über den Treiber und die Firmwareversion an. Es gibt an
dieser Stelle ein Verbindung zum Fehlerbehebungs-Leitfaden.

Drop-Out-Detection-Sektion

Die Drop-Out-Detection-Sektion besteht aus zwei Anzeigen und einem Button:

▪ USB I/O Errors (USB-Eingabe-/Ausgabe-Fehler): zählt die USB-Eingabe-/Ausgabe-Fehler.
Eine große Anzahl an USB-Eingabe-/Ausgabe-Fehlern deutet daraufhin, dass Ihr System
überlastet ist.

▪ Buffer Underruns (Pufferleerlauf): Zu einem Leerlauf des Puffers kommt es, wenn Ihr
Computer nicht in der Lage ist, den Puffer schnell genug mit Daten zu füllen. Die Gründe
für einen Leerlauf können darin liegen, dass zu viele Hintergrundprozesse ausgeführt wer-
den oder eine Musik-Software, die das Gerät als Audiotreiber verwendet, für eine zu hohe
CPU-Auslastung sorgt.

▪ Reset (zurücksetzen): Durch Drücken dieses Buttons wird der Fehlerzähler zurückgesetzt.

Connection-Monitor-Sektion (Verbindungsanzeige)

Die Connection-Monitor-Sektion besteht aus zwei Anzeigen und einem Button:

▪ Number of Clients (Anzahl der Verwender): zeigt die Anzahl der Programme an, die auf
das Interface zugreifen. Verschiedene ASIO-Anwedungen werden separat gezählt, WDM
und WASAPI erhöhen die Anzahl um eins, unabhängig davon, wieviele der WDM-/WASA-
PI-Anwendungen Audio abspielen.

▪ USB Data Errors (USB-Datenfehler): zählt die USB-Datenfehler. Als Auslöser für Daten-
fehler auf dem USB-Bus kommen zu lange oder schlechte Kabel oder Einstreuungen in
Frage.

▪ Reset (zurücksetzen): Durch Drücken dieses Buttons wird der Fehlerzähler zurückgesetzt.

System-Performance-Test-Sektion (Systemleistungstest)

▪ Current Latency: Klicken Sie unten auf den Start-Button, um den aktuellen Latenzwert
anzuzeigen.

▪ Maximum Latency: zeigt den höchsten Latenzwert an, der im aktuellen Messzyklus ge-
messen wurde.
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◦ Wenn Sie auf Reset klicken, hat dies denselben Effekt, als wenn Sie zum ersten Mal
auf Start klicken. Alte Werte werden gelöscht und es startet ein neuer Testlauf mit neu-
en Werten.

◦ Durch Drücken auf Stop beenden Sie den Test. Der Maximum-Latency-Wert wird wei-
terhin angezeigt.

Information-Sektion

Die Information-Sektion besteht aus zwei Anzeigen und einem Button:

▪ Driver Version (Treiberversion): Hier können Sie die Version des installierten Treibers er-
kennen.

▪ Firmware Version: Hier können Sie die aktuell installierte Firmware erkennen.

▪ Troubleshooting Guide (Fehlerbehebungs-Leitfaden): Klicken Sie auf Show, um den Feh-
lerbehebungs-Leitfaden zu öffnen.

6.2 Experteneinstellungen unter Mac OS X
 

Unter Mac OS X können Sie alle nötigen Einstellungen im "Audio and MIDI Settings"-Fenster
vornehmen. Schlagen Sie weitere Informationen bitte in Abschnitt ↑5.3, Konfiguration nach.
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7 Die RIG KONTROL als Controller verwenden

 

Die RIG KONTROL erhöht die Effizienz und nicht zuletzt den Spaß bei der Bedienung von
GUITAR RIG, indem sie sich perfekt als Hardware-Controller integriert. Neben der eingebauten
Controller-Fähigkeit stehen MIDI Verbindungen und zwei Stecker für externe Fußschalter und
Pedale zur Verfügung. Die folgenden Abschnitte erklären, wie Sie die Hardware einrichten, um
diese Fähigkeiten voll auszunutzen. Um zu lernen, wie Sie Funktionen der Software mit Con-
trollern verknüpfen, lesen Sie bitte die Software-Handbücher.

Um die RIG KONTROL als Standard-MIDI-Controller zu verwenden, müssen Sie die bei der In-
stallation enthaltene Controller Editor Software benutzen. Bitte lesen Sie die entsprechende
Dokumentation, um Näheres zu erfahren.

7.1 Aktivieren der RIG KONTROL in GUITAR RIG
 

Sofern eine RIG KONTROL verbunden ist, wird sie in GUITAR RIG automatisch aktiviert. Beim
ersten Mal werden Sie dazu aufgefordert, das Fußpedal zu kalibrieren. Bitte bewegen Sie das
Pedal einmal ganz runter und einmal ganz hoch und klicken Sie zur Bestätigung auf OK. Um
das Pedal erneut zu kalibrieren, klicken Sie auf Options und wählen Sie Preferences. Klicken
Sie nun auf den Button Reset neben RIG KONTROL Pedal Calibration.

Die RIG-KONTROL-Hardware hat eine graphische Entsprechung in GUITAR RIG, die angezeigt
wird, nachdem Sie auf den Button Rig Kontrol Anzeigen/Ausblenden über dem Rack klicken.

Falls Sie mehrere Instanzen von GUITAR RIG laufen haben (z. B. in einem Sequencer), wollen
Sie wahrscheinlich definieren, welche davon durch die RIG KONTROL gesteuert wird. Stan-
dardmäßig wird die RIG KONTROL in der zuerst gestarteten Instanz aktiviert. Wenn Sie jedoch
in einer anderen Instanz von GUITAR RIG auf den Button Connect der Virtual Rig Kontrol kli-
cken, wechselt der Fokus auf diese – es kann immer nur eine Instanz durch die RIG KONTROL
kontrolliert werden!

Einige Funktionen sind den Fußschaltern 5-8 bereits als Standardeinstellung zugewiesen – sie
sind durch Textlabels auf der Hardware kenntlich gemacht. Sie können mit den Schaltern 5
(Preset Prev) und 6 (Preset Next) durch alle Presets schalten, die derzeit in der Preset-Liste
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angezeigt werden. Schalter 7 und 8 dienen zur Aktivierung des Tuners, und um das Metronom-
Tempo per Fuß einzustellen. Natürlich können auch diese Schalter anderen Funktion zugewie-
sen werden.

Der einfachste Weg, einem Schalter oder Pedal der RIG KONTROL eine Funktion im Rack zu-
zuweisen, ist Drag and Drop: Klicken Sie auf das Label unter einem Button auf der Virtual Rig
Kontrol und ziehen Sie es auf den zu kontrollierenden Parameter, bevor Sie die Maustaste wie-
der loslassen! Für eine detaillierte Beschreibung von Controller-Zuweisungen lesen Sie bitte
die Software-Handbücher zu GUITAR RIG.

7.2 Verwenden von MIDI-Controller-Geräten am MIDI-Interface der RIG
KONTROL

 

Während die RIG KONTROL in der Lage ist, andere Applikationen per MIDI zu steuern, kom-
muniziert sie mit GUITAR RIG über ein spezielles Protokoll via USB. Davon unabhängig verfügt
sie über ein Standard MIDI Interface mit einem Eingang und einem Ausgang.

Um einen via MIDI Kabel verbundenen Controller zu benutzen, stellen Sie sicher, dass der RIG
KONTROL MIDI Kanal in GUITAR RIG aktiviert ist:

1. Öffnen Sie die "Audio and MIDI Settings". Unter Windows befinden sie sich im File-Menü,
unter Mac OS X im Menü "Guitar Rig".

2. Gehen Sie zum MIDI-Tab.
3. Suchen Sie den Eintrag Rig Kontrol in der Tabelle Inputs, und aktivieren Sie ihn, indem

Sie in die Spalte Status klicken.
Den MIDI-Eingangskanal wählen Sie in GUITAR RIG unter Options: Klicken Sie auf dem Prefe-
rences-Tab auf das Drop-Down-Menü MIDI channel und wählen Sie einen der Kanäle 1-16
oder den Eintrag omni. Um zu erfahren, wie Sie mit externen MIDI-Controller-Geräten Funktio-
nen von GUITAR RIG steuern, lesen Sie bitte das Einführungshandbuch "Erste Schritte" (Ge-
tting Started) und das Software-Handbuch (Application Reference).
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7.3 Zusätzliche Fußschalter und Pedale verwenden
 

Die RIG KONTROL verfügt über zwei ¼” Anschlüsse, um externe Fußschalter und Pedale zu
verbinden. Nachdem diese verbunden und eingerichtet wurden, können Sie in GUITAR RIG ge-
nau wie MIDI Controller zugewiesen werden. Bitte konsultieren Síe die Software-Handbücher,
um mehr darüber zu erfahren.

Unter den Preferences auf der Options-Seite sind die folgenden Einstellungen verfügbar:

► Um ein externes Pedal zu kalibrieren, klicken Sie auf den Button Reset neben RIG KON-
TROL Ext Pedals Calibration.

Die Zeilen RIG KONTROL Ext Pedal 1/2 Mode erlauben die Konfiguration beider Eingänge,
um sie an Ihren externen Fußschalter oder Pedal anzupassen. Bitte konsultieren Sie die Pro-
duktspezifikation des Herstellers, um herauszufinden, ob Ihr Pedal Tip- oder Ring-aktiv ist,
bzw. ob Sie einen öffnenden (opening) oder schließenden (closing) Fußschalter besitzen.
Falls Probleme auftauchen, probieren Sie den jeweils anderen Modus aus.
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8 Fehlersuche

 

Sollten Sie auf Probleme mit Ihrer Hardware stoßen, führen Sie die folgenden Schritte durch,
um eine Lösung zu finden, bevor Sie den Technischen Support kontaktieren:

▪ Besuchen Sie die NI Knowledge Base im Internet. Am einfachsten finden Sie die Know-
ledge Base, indem Sie in GUITAR RIG aus dem Help-Menü den Eintrag Visit the Know-
ledgebase... wählen.

▪ Besuchen Sie das NI User Forum auf unserer Website:
http://www.native-instruments.com/forum/

Bevor Sie den Technischen Support kontaktieren, stellen Sie bitte sicher, dass Sie alle rele-
vanten Informationen zu Ihrem Computer zur Hand haben. Für Informationen zur Treiber- und
Firmwareversion, konsultieren Sie das Driver-Control-Panel:

▪ Auf Computern mit Windows-Betriebssystem finden Sie Treiber- und Firmware-Version im
Bedienfeld von RIG KONTROL. Öffnen Sie aus dem Software-Ordner von Native Instru-
ments den Ordner Rig Kontrol 3 und führen Sie einen Doppelklick auf Rig Kontrol 3 Con-
trol Panel aus. Die Informationen werden angezeigt, wenn Sie auf Help > About Rig Kon-
trol 3 Control Panel klicken.

▪ Auf Computern mit dem Betriebssystem Mac OS X können Sie das Driver-Control-Panel
aus den Systemeinstellungen aufrufen. Die Informationen werden im Hauptfenster ange-
zeigt.

Bitte besuchen Sie die folgende URL, um das Support Team zu kontaktieren:

http://www.native-instruments.com/support/

Alle Produkte von Native Instruments werden während der Entwicklungsphase ausgiebig in ver-
schiedenen Anwendungssituationen getestet. Sollte Ihr Produkt dennoch umgetauscht werden
müssen, wird Ihnen das Technik Support Team eine RA (Return Authorization) Nummer zuwei-
sen, um die Verarbeitung Ihrer Umtauschware zu beschleunigen. Bitte kontaktieren Sie vor
Einsendung jeglicher Ware unser Technik-Support-Team. Pakete, die ohne die RA-Nummer
eingeschickt werden, können nicht genau zugeordnet und somit nicht mit der maximalen Ge-
schwindigkeit bearbeitet werden.
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8.1 Audio-Probleme beheben
 

Dieser Abschnitt enthält hilfreiche Informationen zu den häufigsten Sound-Problemen.

8.1.1 Keine oder sehr leise Wiedergabe
 

Es gibt verschiedene Ursachen für einen stummen oder sehr leisen Audio-Ausgang:

▪ Eine häufige Fehlerquelle sind fehlende Audioverbindungen oder defekte Kabel. Bitte
überprüfen Sie sämtliche Verbindungen und alle Kabel auf ihre Funktion.

▪ Falsche Soundkarte oder falscher Audio-Eingang ausgewählt. Überprüfen Sie bitte in den
„Audio and MIDI Settings“ von GUITAR RIG, ob der Treiber der RIG KONTROL ausge-
wählt ist.

▪ Im Input-Modul von GUITAR RIG ist der falsche Kanal angewählt. Verbinden Sie Ihr In-
strument mit der anderen Eingangsbuchse der RIG KONTROL, oder schalten Sie in der
Kopfzeile der Bedienoberfläche auf den anderen Kanal um.

▪ Der Input-Gain-Regler der RIG KONTROL ist möglicherweise zu niedrig eingestellt. Dre-
hen Sie den Regler auf, um den Eingangspegel zu erhöhen.

▪ Der Lautstärkeregler Ihrer Gitarre ist heruntergeregelt. Drehen Sie den Regler auf.

8.1.2 Verzerrtes Signal
 

Wenn die Tonausgabe verzerrt klingt, obwohl Sie in keinen Distortion-Effekt einsetzen, ist mög-
licherweise die Eingangsempfindlichkeit der RIG KONTROL zu hoch eingestellt. Bitte regeln
Sie das „Input Level“ der RIG KONTROL herunter, um eine Übersteuerung der Vorstufe zu ver-
meiden. Sollte sich die Übersteuerung der Vorstufe so nicht beheben lassen, verringern Sie
bitte die Lautstärke an der Gitarre selbst. Dieser Fall tritt normalerweise nur bei Gitarren und
Bässen mit aktiver Elektronik und Tonabnehmern mit besonders starkem Ausgangssignal auf.

8.1.3 Störgeräusche
 

Vernehmbares Brummen in der Wiedergabe kann verschiedene Ursachen haben:
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▪ Single-Coil-Tonabnehmer sind sehr anfällig für elektrische Einstreuungen, die Brummen
verursachen können. Humbucker sind in dieser Hinsicht deutlich weniger sensibel.

▪ Die Tonabnehmer befinden sich in der Nähe von elektrischen Geräten. Um das Brummen
zu reduzieren, entfernen Sie die Gitarre weiter von den Geräten.

▪ Der Lautstärkeregler der Gitarre ist nicht weit genug aufgedreht. Drehen Sie den Regler
auf. Sollte Ihre Gitarre mehrere Regler haben, überprüfen Sie bitte alle Einstellungen.

▪ Sie benutzen ein ungeschirmtes oder defektes Gitarrenkabel. Tauschen Sie in einem sol-
chen Fall Ihr Gitarrenkabel gegen ein hochwertiges, abgeschirmtes Modell aus. Die Ab-
schirmung Ihrer Gitarre kann ebenfalls unzureichend sein. Ein Fachmann kann Ihre Gitar-
re instandsetzen und eine neue Abschirmung anbringen.

Falls Sie starkes Rauschen vernehmen, reicht die Vorverstärkung durch die RIG KONTROL
möglicherweise nicht aus. Stellen Sie sicher, dass die Lautstärke Ihres Instruments voll aufge-
dreht ist, und drehen Sie den Input-Gain des entsprechenden Eingangs der RIG KONTROL
auf. Weitere Informationen zum Einstellen des Eingangspegels finden Sie in Abschnitt (Wind-
ows) und im Abschnitt (Mac OS X) in diesem Handbuch.

8.1.4 Masseschleifen
 

Masseschleifen (normalerweise als Brummen oder Summen wahrgenommen) sind ein verbrei-
tetes Problem, wenn verschiedene elektrische Geräte an den gleichen Stromkreis angeschlos-
sen sind. Die folgenden Schritte sollten bei der Behebung helfen:

► Trennen Sie alle Geräte vom Stromkreis, die Sie zur Zeit nicht benutzen, z. B. Peripheriege-
räte Ihres Computers (externe Festplatten, CD-/DVD-Brenner).

► Schalten Sie eine DI-Box zwischen den Ausgang der RIG KONTROL und den Eingang Ihres
Verstärkers. Die meisten DI-Boxen verfügen über einen „Ground Lift“-Schalter, der es ermög-
licht, die Masseschleife zu unterbrechen.

8.2 Probleme mit der Hardware
 

Weitere Informationen, Software-Updates sowie die neuste Treiber-Version für die RIG KON-
TROL erhalten Sie auf der Native-Instruments-Website und über das NI Service Center.
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8.2.1 Treiberprobleme
 

Stellen Sie sicher, dass die RIG KONTROL mit dem Computer verbunden ist und öffnen Sie
das Driver-Control-Panel. Am Anfang dieses Kapitels ist erklärt, wo sich das Driver-Control-Pa-
nel befindet.

Falls das Driver-Control-Panel nicht auffindbar ist, ist der Treiber mit hoher Wahrscheinlichkeit
nicht installiert. In diesem Falle installieren Sie den Treiber bitte erneut wie oben beschrieben.

Falls im Driver-Control-Panel alle Menüs ausgegraut sind, wird die RIG KONTROL nicht vom
Treiber erkannt. Dies kann an einer fehlerhaften USB-Verbindung liegen – lesen Sie den fol-
genden Abschnitt für Details.

8.2.2 USB-Probleme
 

Die RIG KONTROL ist ein USB 2.0 Interface und wird an einem USB 1.0/ 1.1 Anschluss nicht
funktionieren. Bitte verbinden Sie sie immer direkt mit einem USB 2.0 Port Ihres Computers.
Die Stromversorgung des Ports muss die Mindestanforderungen für USB 2.0 erfüllen, also ei-
nen Strom von 500 mA liefern können. An manchen Computern erfüllen die USB-2.0-Ports
die offiziellen USB-2.0-Spezifikationen nicht. In diesem Fall erscheint eventuell eine Warn-
meldung, die Sie darauf hinweist, dass nicht genug Strom für die Versorgung Ihres Geräts zur
Verfügung steht. Die RIG KONTROL wird nur fehlerhaft oder gar nicht funktionieren.

▪ Falls Ihr Computer nicht in der Lage ist, eine ausreichende Stromversorgung zu garantie-
ren, versuchen Sie, die RIG KONTROL als einziges Gerät an einen USB 2.0 Hub mit ex-
terner Stromversorgung anzuschließen. Vermeiden Sie es, weitere bus-gespeiste Geräte an
den Hub anzuschließen, weil jedes zusätzliche Gerät die für die RIG KONTROL zur Verfü-
gung stehende Stromstärke reduziert.

▪ Im Falle einer Funktionsstörung überprüfen Sie zunächst, ob die RIG KONTROL funktio-
niert, wenn Sie andere USB-Geräte von Ihrem Computer trennen.

▪ Falls bei der Audio-Wiedergabe Aussetzer oder andere Probleme auftreten, verbinden Sie
die RIG KONTROL mit einem anderen USB-2.0-Port.

▪ Ein defektes USB-Kabel kann die Ursache für eine fehlerhafte Wiedergabe und andere
Verbindungsprobleme sein. Testen Sie ein anderes Kabel mit dem offiziellen USB-Logo,
in einigen Fällen kann die Verwendung eines kürzeren Kabels hilfreich sein.

Fehlersuche
Probleme mit der Hardware

 

RIG KONTROL 3 - Benutzerhandbuch - 48



▪ Falls Sie auf einem Computer mit Windows-Betriebssystem Performance-Probleme und
Abstürze mit der RIG KONTROL erleben, sollten Sie zuerst das Energiemanagement für
USB-Hubs deaktivieren. Öffnen Sie den Gerätemanager (Systemsteuerung > System >
Hardware) und erweitern Sie die Liste der USB-Controller. Klicken Sie mit der rechten
Maustaste auf einen der USB-Hubs, um seine Einstellungen zu bearbeiten. Deaktivieren
Sie auf der Registerkarte „Energieverwaltung“ alle Checkboxen und wiederholen Sie den
Vorgang für alle USB-Hubs in der Liste. Wiederholen Sie diesen Schritt für jeden Hub und
starten Sie den Rechner neu.

8.2.3 Verwenden der RIG KONTROL mit einem Laptop
 

Überprüfen Sie, ob Ihr Computer leistungsfähig genug ist, um Audiosignale ohne Aussetzer in
Echtzeit zu verarbeiten. Es gibt einige Freeware-Programme, um Ihr System auf seine Zuverläs-
sigkeit bei der Audio-Signalverarbeitung zu analysieren, zum Beispiel:

www.thesycon.de/deu/latency_check.shtml

Trennen Sie die Verbindung zwischen GUITAR RIG und Ihrem Computer und starten Sie dann
das Programm. Falls Ihr Computer nicht in der Lage ist, Audio in Echtzeit zu verarbeiten, wer-
den Sie rote Balken und eine entsprechende Analyse in der Textbox sehen.

Es ist generell nicht zu empfehlen, Laptops mit Shared-Memory Grafikkarten zu benutzen. Sie
werden den gesamten verfügbaren Speicher und die CPU-Leistung für Ihre Audioprojekte brau-
chen.

Dies sind einige nützliche Schritte, um die Audio-Performance Ihres Laptops zu steigern:

► Verwenden Sie den Laptop möglichst nicht im Batteriebetrieb, da die Energieverwaltung die
Taktrate der CPU herunterregeln kann, um Strom zu sparen.

► Entfernen Sie jegliche Peripheriegeräte, die Sie nicht benutzen (Drucker, Scanner, etc.).
Dies kann die verfügbare Prozessorleistung erhöhen.

► Laptops sind häufig mit integrierten Geräten ausgestattet, die zu Fehlern in der Audioverar-
beitung führen können. Eine weit verbreitete Fehlerquelle sind Netzwerk- oder W-LAN-Adapter.
Es kann notwendig sein, diese Geräte zu deaktivieren, während Sie mit der RIG KONTROL ar-
beiten.
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9 Technische Spezifikationen

 

Dieser Abschnitt enthält alle relevanten technischen Spezifikationen der RIG-KONTROL-Hard-
ware.

9.1 Anschlüsse und Buchsen
 

▪ 2 Eingangs-Buchsen (In 1 und In 2) für monophone 6,3 mm (1/4 inch) Klinkenstecker

▪ 2 Ausgangs-Buchsen (Out 1, Out 2) für monophone 6,3 mm (1/4 inch) Klinkenstecker,
symmetrisch oder unsymmetrisch

▪ 1 Kopfhörer Ausgang für stereophone 6,3 mm (1/4 inch) Klinkenstecker

▪ 2 Eingangsbuchsen für externe Pedale, Fußschalter oder Umschaltboxen

▪ (Pedal 1, Pedal 2) für stereophone 6,3 mm (1/4 inch) Klinkenstecker

▪ 2 MIDI (In/Out) für 5-Pol-DIN-Stecker

▪ 1 USB 2.0 Buchse Typ B

9.2 Audiospezifikationen
 

Audioeingänge (A/D)  

Kanäle 2

Samplingrate (Abtastfrequenz) 44.1, 48, 88.2, 96, 192 kHz

Bit-Auflösung 16, 24 Bit

Wandler Cirrus Logic
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Instrumenten-Eingänge  

Eingangswiderstand 1 MOhm

Endausschlagspegel bei maximaler
Verstärkung

-11.5 dBu

Maximaler Eingangspegel +16 dBu

SNR (gewichtet) > 100 dB

THD+N 00,009 %

Frequenzbereich (+/- 1 dBu) +/- 0,5 dB, 20 Hz - 24 kHz

Dynamikumfang 105 dB (AD-Konverter)

 

Line-Eingänge  

Eingangswiderstand 44 kOhm

Endausschlagspegel bei maximaler
Verstärkung

-5.5 dBu

Maximaler Eingangspegel +16 dBu

SNR (gewichtet) > 100 dB

THD+N 00,009 %

Frequenzbereich (+/- 1 dBu) +/- 0,5 dB, 20 Hz - 36 kHz

Dynamikumfang 105 dB (AD-Konverter)

 

Audioausgänge (D/A)  

Kanäle 2

Samplingrate (Abtastfrequenz) 44.1, 48, 88.2, 96, 192 kHz

Bit-Auflösung 16, 24 Bit

Wandler Cirrus Logic
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Line-Ausgänge  

Ausgangswiderstand 100 Ohm

Maximaler Ausgangspegel +6.3 dBu

SNR (gewichtet) > 100 dB

THD+N 00,010 %

Frequenzbereich (+/- 1 dBu) +/- 0,5 dB 22 Hz - 44 kHz

High/Low Pegelumschalter Vollausschlag 5 Vpp / -14 dB

 

Kopfhörerausgang  

Lastimpedanz 8-600 Ohm

Maximaler Ausgangspegel 1,61 V rms @ 100 Ohm

SNR (gewichtet) > 91 dB

THD+N (60 Ohms) 00,013 %

Frequenzbereich (+/- 1 dBu) +/- 0,5 dB 22 Hz - 44 kHz

9.3 Stromversorgung
 

via USB 2.0 Schnittstelle (Buspower mit 5 V, 500 mA). Es wird nur Strom vom USB-Bus be-
nötigt, kein Netzteil oder Batterie erforderlich. Ein störungsfreier Betrieb kann jedoch nur dann
gewährleistet werden, wenn die RIG KONTROL als einziges Gerät entweder direkt an einen
USB-2-Controller oder an ein aktives (also per Netzteil versorgtes) USB-2-kompatibles Hub an-
geschlossen ist.

9.4 Abmessungen und Gewicht
 

▪ Abmessungen: 360 x 237 x 102 mm (14,1 x 9,3 x 4 in)

▪ Gewicht: 2,6 kg (5,7 lb)

Technische Spezifikationen
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9.5 Umgebungsbedingungen:
 

▪ Betriebstemperatur: 0°C bis 40°C (32°F bis 104°F) (85 % Luftfeuchtigkeit, nicht kon-
densierend)

▪ Lagertemperatur: -20°C bis 50°C (-4°F bis 122°F) (85 % relative Luftfeuchtigkeit)

9.6 Systemanforderungen
 

▪ Mac OS X 10.6 (neustes Update), Intel Core Duo, 1 GB RAM, USB 2.0

▪ Windows 7 (neustes Service Pack, 32/64 Bit), Intel Core Duo oder AMD Athlon 64, 1 GB
RAM, USB 2.0

Technische Spezifikationen
Umgebungsbedingungen:
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